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1 Introduction to the Natural Wrapper

The Natural Wrapper is part of the EntireX Workbench in Software AG Designer. It supports users
to develop Natural client applications that access RPC-based server components and to create
Natural RPC server skeletons which you can use as a basis for writing Natural RPC servers that
can be accessed by RPC clients.

The Natural Wrapper starts with a Software AG IDL file that describes the interfaces of the RPC
server or RPC client components. During wrapping the IDL program names are mapped to suitable
Natural names, which you can customize. This means that IDL program and IDL library names
can be longer than eight characters and can even contain characters not allowed in Natural names.

For Natural client applications it generates the following:
® Natural client interface objects (which are Natural subprograms; file extension .NSN) that can

be used in Natural client applications to access a remote RPC component.

" Parameter data areas (PDA; one for each client interface object; file extension .NSA) defining
the interface to the Natural client interface objects. It is recommended to use the PDA in your
Natural client application.

® Sample Natural program (one for each interface object; file extension .NSP) that demonstrate
how to call the client interface object. See Sample Generation Result for the Client Side for more
information.

® In addition, a helper local data area (LDA), NATRPCL, can be generated to support correct
local compilation in a NaturalONE project in Software AG Designer. See Step 1: Specify the
RPC Environment.

For Natural server applications it generates the following:

® Natural RPC server skeletons (which are Natural subprograms; file extension .NSN).

® Parameter data areas (PDA; one for each server skeleton; file extension .NSA) defining the inter-
face to the RPC server.
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® If the server names (automatically generated or customized) differ from the IDL program names
a client-side server mapping file is required, see CVM File. It is generated during generation of
the RPC Server and has to be used in subsequent steps (wrapped into RPC client components).

You need a Natural RPC environment - a Natural RPC server attached to an EntireX broker - to
generate the Natural objects listed above from the IDL file. The Natural version determines
whether the generation of all Natural objects listed above is supported. See Prerequisites in the
EntireX Release Notes for more information.
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Starting the Natural Wrapper

Start the Natural Wrapper from the context menu of an IDL file: Generate Natural from Software

AG IDL.

s — —
= NaturalONE - NatONE-NaturalClient/Natural-Libraries/NEWLIB/RES/MYLIB.id! - Eclipse SDK - Di\devEclipse\headCompileTarget\workspace

= | B S |

File Edit Mavigate Search Project Run  Window Help
i &8 Q- F R v e ﬁ Service Devel.. [ EntireX %% Debug >
T Navigator 53 2| B&|.8 f ¥ = Oz MyLB.idl 2 =0
igat = |
a b# MatOME-MaturalClient-»natu New » Library 'MYLIE' is -
[ = settings Open Program 'CRLC' is
4 [F= Matural-Libraries * Open With b define data para]fleter
- &= MYLIB 1 operator (Rl) in
4 (= NEWLIB * L:i:flcopy 1 operandl (I4) in
@ ERR Paste | 1 operand2 (I4) in
4 @ RES * xDeIete 1 result (i4) out
Iial\f'l\-‘l_lﬂ.idl’\\ Move... end-define
MYLIB,, rti E
& c Rl . Program 'HELLO' is
S It define data parameter
.natural =3/mport...
= A Export... 1 name (&AV) In
1 project b 1 Hello (AV) out
I» I Natural-Extractor & | Refresh end-define
i+ = Matural-OBJ-RPC-> <unknowi
et Pl e NaturalONE ' = pProgram 'SQUARE' is
=H Natural Server &4 Testing » [ B define data parameter
=] =§! lncalhosk-2800 Code Generation 4 1 Value (I4) IN
CE User Libraries B Upload 1 Result (I4) out
L) System Libraries a p. o2 . end-define
%, Build Project
Validate
Edit XML Mapping of Software AG IDL
Generate Web Service from Software AGIDL ...
Test Software AG IDL... -
Generate webMethods IS Connection from Software AG IDL... 1 4
Generate DCOM from Software AG IDL B Console E‘u Problemq ‘Zl Taskq =5
Deploy/Synchronize Server Mapping... Natural Build - "
Edit COBOL Mapping of Software AG IDL sturafbuticer GefpBle# B -~
Run As » B
Debug As 3
Profile As »
Team »
Replace With »
Generate PL/T from Software AG IDL » -
Generate .NET from Software AG IDL 3 ] 3
o* NatONE-Natura\CIientjhl Generate Matural from Software AG IDL » RPC Client...
! Refactor Software AG IDL » RPC Server...
Generate EJB from Software AG IDL 3
Generate Java from Software AG IDL »
Generate COBOL from Software AG IDL 3
Generate C from Software AG IDL »
JPA Tools »

Properties
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Using the Natural Wrapper for the Client Side

= Using the Natural Wrapper for the Client Side within NaturalONE
= Using the Natural Wrapper for the Client Side with a Remote RPC Environment
= Sample Generation Result for the Client Side

Using the Natural Wrapper for the Client Side within NaturalONE

= Step 1: Specify the RPC Environment
= Step 2: Customize Natural Client Names

Step 1: Specify the RPC Environment

The first wizard page prompts you to select an existing RPC environment or define a new one.
When running with NaturalONE, a default RPC environment is available. This is typically named
"localhost:1971@NATSRV2800" and refers to a running EntireX broker and Natural RPC server
on the local machine.

EntireX Natural Wrapper 9
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P

= MNatural Wrapper l | (=] |ﬁ

Generate Natural Interface Objects
The Matural interface objects will be generated from the selected Software AG IDL file. =

This Wizard will help you to generate Matural interface objects from a Software AG IDL file,
Select or create a new RPC environment.

(") Create a new RPC environment

@ iUse existing RPC environment:

! localhost:1971 @RPC/NATSRV2800/CALLNAT

[l Modify the selected RPC environment

@ < Back Mext = | [ Finish ] | Cancel

e

Check Use existing RPC environment, select the default RPC environment for NaturalONE and
press Next. Continue with Step 2: Customize Natural Client Names.

Changing the default RPC environment for NaturalONE is not required and not recommended,
so it is best to uncheck Modify the selected RPC environment. More information on changing an
RPC environment can be found in Step 2: Edit the RPC Environment (Optional) under Using the
Natural Wrapper for the Client Side with a Remote RPC Environment.

To use a different Natural RPC server for generation, create a new RPC environment. See Step 1:

Specify the RPC Environment under Using the Natural Wrapper for the Client Side with a Remote
RPC Environment.

6 EntireX Natural Wrapper
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Step 2: Customize Natural Client Names

On this page, adapt the names for the Natural client interface objects (subprograms (NSNs) with
their parameter data areas (PDAs)), names of the client test programs and specify the location to
which all Natural sources are to be written. The generation of client test programs can be disabled.

= Matural Wrapper L =] -zhl
Customize Natural Client Names Used for IDL Library MYLIB
On this page you can adapt the names to be used for Natural Client Subprograms, Matural Client PDAs and Matural S
Client Test Programs. You can dizable the generation of Matural Client Test Programs.
Adapt names used for Matural Clients and select Matural Client Test programs you need:
IDL Program Client Subprogram  Client PDA Test Program
FcaLc CALC CALCA CALCP
PHELLO HELLO HELLOA HELLOP
P SQUARE SQUARE SQUAREA SQUAREP
V] Generate Test Programs Custormize the generation of Matural Test programs... Total: 3
Location for the generated Matural Sources
Container:  /NatONE-NaturalClient/Natural-Libraries/MEWLIE/RES
3
'\3_,' Mext = [ Finish l [ Cancel ]
.

| Note: If your IDL file contains more than one IDL library, the additional column IDL Library
is displayed.

Check Generate Test Programs if client test programs for client interface objects are to be generated.
Uncheck if no test programs are to be generated. Use the link Customize the generation of Natural
Test programs to specify for each IDL program whether a test program is generated or not. See
Generate Test Programs for more information.

For Natural ONE, the Location for the generated Natural sources should be in a Natural project.
If the target container is a source folder of a Natural project, the Natural builder will automatically
compile and build the source.

These features require support from the Natural RPC server used for generation. If you are using
an older version:

® Names for Natural sources (NSNs, PDAs etc.) cannot be defined by the user. In this case no
name table and no check box to generate test programs are displayed.

® No client test programs are generated. In this case the names for the client test programs cannot
be edited and no check box to generate test programs is displayed.

EntireX Natural Wrapper 7
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See Prerequisites for Natural Wrapper in the respective section of the Release Notes for version
number required.

Press Next to start generation.
Generate Test Programs

On this page, specify for each IDL program whether a client test program is generated or not.

e B T 3
= Matural Client Names @
Manage the generation of Natural Client Test Programs for IDL Library MYLIB -

On this page you can manage the generation of Matural Client Test Programs by using the check-boxes.
Select the Matural Client Test programs to be generated

Test Program IDL Program

CALCP &F ralc

HELLOP 4" HELLO

SQUAREP 47 SQUARE

Selected: 3 of 3
@:l [ OK ] [ Cancel ]

ke I 3 = ¥

Check the IDL programs for which a client test program is to be generated. If a box is unchecked,
no client test program is generated for that IDL program. Press OK to save the settings.

8 EntireX Natural Wrapper
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Using the Natural Wrapper for the Client Side with a Remote RPC Environment

= Step 1: Specify the RPC Environment

= Step 2: Edit the RPC Environment (Optional)

= Step 3: Select a Library (Optional)

= Step 4a: Customize Natural Client Names and Save Remotely (Optional)
= Step 4b: Customize Natural Client Names and Save Locally (Optional)

Step 1: Specify the RPC Environment

The first wizard page prompts you to use an existing RPC environment or create a new one.

= Matural Wrapper l | [5] |$J

-

Generate Natural Interface Objects ey
The Matural interface objects will be generated from the selected Software AG IDL file.

This Wizard will help you to generate Matural interface cbjects from a Software AG IDL file,
Select or create a new RPC environment.

(") Create a new RPC envirenment

@ Use existing RPC environment: |

= ibmhost2:5403@RPC/NATSRVE2/CALLNAT

[ Modify the selected RPC envirenment

@:‘ < Baclk Mext = | [ Finish ] | Cancel

» To use an existing RPC environment

1 Check Use existing RPC environment, select the desired RPC environment and press Next.
If your previously defined filter (see Step 2: Edit the RPC Environment (Optional)) matches
more than one Natural library, continue with Step 3: Select a Library (Optional). If the filter

EntireX Natural Wrapper 9
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matches exactly one Natural library, continue with Step 4a: Customize Natural Client Names
and Save Remotely (Optional).

2 Check Modify the selected RPC environment if you want to change settings prior to gener-
ation. Press Next and continue with Step 2: Edit the RPC Environment (Optional).

» To create a new RPC environment

m  Check Create a new RPC environment and press Next. Continue with Step 2: Edit the RPC
Environment (Optional).

Step 2: Edit the RPC Environment (Optional)

On this page, connection and authentication settings for the EntireX Broker and Natural RPC
server are managed, and you define if the Natural client interface objects are saved remotely on
the Natural RPC Server or locally within Software AG Designer.

10 EntireX Natural Wrapper
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r N

= Matural Wrapper SRR X

-

Edit RPC Environment

Define a new RPC Environment.

Broker Parameters

Broker ID: * ibmhost2:5403

Server Address: * RPC/NATSRVEZ/CALLMAT

Timeout (Seconds): 60

EntireX Authentication RPC Server Authentication
User Il RPC UserID:

Password: RPC Password:

Extractor Settings

Enter narnes, or use filter for range of values (wildcards * and ? on any position, < and > as final character only).

Library Name:

Program Mame:

Wrapper Settings
() Save locally

(@ Save remotely

Target Library Mame: © NAT*

Environment Name

() Default (ilbmhost2:5403@RPC/NATSRVEZ/CALLMNAT)
................... ibmhost2:5403@RPC/NATSRVEZ /CALLMAT

® |

Finish

Define a new RPC environment or modify an existing one on this page. Required fields are Broker
ID, Server Address and the Environment Name. The timeout value must be in the range 1-9999
seconds (default: 60).

The EntireX Authentication fields apply to the broker.

The RPC Server Authentication fields apply to the RPC server. If the Natural RPC Server is oper-
ating under Natural Security:

EntireX Natural Wrapper "
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® Your user ID and password must be defined in Natural Security. If the Natural Security user
ID or password differs from the broker user ID and password, use RPC Server Authentication
- otherwise use EntireX Authentication for both.

" Access to the Natural system library SYSIDL is required.
You can save the generated Natural sources locally or remotely:

* Locally
Sources are saved locally in the Software AG Designer. This setting is preferred if you develop
with Natural ONE and will additionally create a helper LDA, NATRPCL for correct local com-
pilation in a NaturalONE project in Software AG Designer. If you select this option, continue
with Step 4b: Customize Natural Client Names and Save Locally (Optional) and save locally.

* Remotely
Sources are saved remotely on the Natural RPC Server. If you save the Natural sources remotely,
you have to specify a target Natural library. Enter either an exact name or use a filter for range
of values. The following wildcards are available:

* asterisk "*" (any position) to list names matching any sequence of characters

" question mark "?" (any position) to list names matching any single character

= greater than ">" (final character only) to list names after

* lower than "<" (final character only) to list names before

Only Natural libraries that reside in the FUSER system file of the Natural RPC server can be

specified. The Natural library specified is not created from the EntireX workbench, it must exist
in the FUSER system file (at least one Natural object stored here).

Press Next. If your filter matches more than one Natural library, continue with Step 3: Select a
Library (Optional). If the filter matches exactly one Natural library, continue with Step 4a:
Customize Natural Client Names and Save Remotely (Optional) and save remotely.

Step 3: Select a Library (Optional)

All Natural libraries that reside in the FUSER system file of the Natural RPC server and that match
the filter defined in Step 2: Edit the RPC Environment (Optional) are listed here. This step is
skipped if exactly one Natural library matches the filter specification defined in Step 2: Edit the
RPC Environment (Optional). In this case, continue with Step 4a: Customize Natural Client Names
and Save Remotely (Optional).

12 EntireX Natural Wrapper
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[ . —— -_— N
= Matural Wrapper — - ———— -
I _am
Select a Library =
The Matural objects will be deployed into the selected library,

List of Matural libraries:

Mame

MAT-1929
MNATCLASS
MNATCLIPS
MNATMFLE
MATMFS
MNATQA
MNATZIP
MATIT071
MAT314

Total: 9

[] Qverwrite existing Natural objects

e ¥

Select the Natural library where you want to save the generated Natural sources and press Next.
Continue with Step 4a: Customize Natural Client Names and Save Remotely (Optional).

Press Finish to skip all preceding steps and start generation immediately. If the generated Natural
objects already exist from a previous generation, check Overwrite existing Natural objects.

Step 4a: Customize Natural Client Names and Save Remotely (Optional)
On this page, adapt the names for the Natural client interface objects (subprograms (NSNs) with

their parameter data areas (PDAs)), and the names of the client test programs. The generation of
client test programs can be disabled.

EntireX Natural Wrapper 13
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r =

= Matural Wrapper SRR X
Customize Matural Client Names Used for IDL Library MYLIB
On this page you can adapt the names to be used for Matural Client Subprograms, Matural Client PDAs and Matural S

Client Test Programs. You can disable the generation of Matural Client Test Programs.

Adapt names used for Matural Clients and select Natural Client Test programs you need:

IDL Program Client Subprogram  Client PDA Test Program
@P CALC CALC CALCA CALCP
@p HELLG HELLO HELLO& HELLOP
QPSQUARE SQUARE SQUAREA SQUAREP
[¥| Generate Test Programs Customize the generation of Matural Test programs... Total: 3

[] Overwrite existing Matural objects

©)

Mext = [ Finish l [ Cancel l

] Note: If your IDL file contains more than one IDL library, the additional column IDL Library
is displayed.

Check Generate Test Programs if client test programs for client interface objects are to be generated.
Uncheck if no test programs are to be generated. Use the link Customize the generation of Natural
Test programs to specify for each IDL program whether a test program is generated or not. See
Generate Test Programs for more information.

If the generated Natural objects already exist from a previous generation, check Overwrite existing
Natural objects.

These features require support from the Natural RPC server used for generation. If you are using
an older version:

® Names for Natural sources (NSNs, PDAs etc.) cannot be defined by the user. In this case no
name table and no check box to generate test programs are displayed.

® No client test programs are generated. In this case the names for the client test programs cannot
be edited and no check box to generate test programs is displayed.

See Prerequisites for Natural Wrapper in the respective section of the Release Notes for version
number required.

Press Next to start generation.

14 EntireX Natural Wrapper



Using the Natural Wrapper

Step 4b: Customize Natural Client Names and Save Locally (Optional)

On this page, adapt the names for the Natural client interface objects (subprograms (NSNs) with
their parameter data areas (PDAs)), names of the client test programs, and specify the location to
which all Natural sources are to be written. The generation of client test programs can be disabled.

i .
= Matural Wrapper - B |-

Customize Natural Client Names Used for IDL Library MYLIB
On this page you can adapt the names to be used for Matural Client Subprograms, Matural Client PDAs and Matural S
Client Test Pragrams. You can disable the generation of Matural Client Test Programs.
Adapt names used for Natural Clients and select Natural Client Test programs you need:
IDL Program Client Subprogram  Client PDA Test Program
&Pealc CALCOON CALCO0A CALCOOP
2P HELLO HELLOOMN HELLOOA HELLOOP
P SQUARE SQUAREN SQUAREA SQUAREP
[¥] Generate Test Programs Customize the generation of Matural Test programs... Total: 3
Location for the generated Matural Sources
Container: /Matural-Wrapper Browse...

] Note: If your IDL file contains more than one IDL library, the additional column IDL Library
is displayed.

Check Generate Test Programs if client test programs for client interface objects are to be generated.
Uncheck if no test programs are to be generated. Use the link Customize the generation of Natural
Test programs to specify for each IDL program whether a test program is generated or not. See
Generate Test Programs for more information.

Specify the Location for the generated Natural sources. Select a container (folder or project) in
Software AG Designer.

These features require support from the Natural RPC server used for generation. If you are using
an older version:

® Names for Natural sources (NSNs, PDAs etc.) cannot be defined by the user. In this case no
name table and no check box to generate test programs are displayed.

® No client test programs are generated. In this case the names for the client test programs cannot
be edited and no check box to generate test programs is displayed.
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See Prerequisites for Natural Wrapper in the respective section of the Release Notes for version
number required.

Press Next to start generation. Continue with Sample Generation Result for the Client Side.
Generate Test Programs

On this page, specify for each IDL program whether a client test program is generated or not.

————— s ——— — 3
= Matural Client Names @
Manage the generation of Natural Client Test Programs for IDL Library MYLIB

On this page you can manage the generation of Matural Client Test Programs by using the check-boxes. S
Select the Matural Client Test programs to be generated
Test Program IDL Program
CALCP & caLc
HELLOP 4" HELLO
SQUAREP 47 SQUARE
Selected: 3 of 3
@:l [ OK ] [ Cancel ]

Check the IDL programs for which a client test program is to be generated. If a box is unchecked,
no client test program is generated for that IDL program. Press OK to save the settings.

Sample Generation Result for the Client Side

The following screen shows the successful generation of .NSN, .NSA, .NSP and .NSL objects. The
Wrapper Settings included Save locally in a NaturalONE environment.
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- -
= NaturalONE - NatONE-NaturalClient/Natural-Libraries/NEWLIB/SRC/CALCP.NSP - Eclipse SDK P — — (= [ 5 [
File Edit Mavigate Search Project Run  Window Help

il =) Fr P F v vx0 oov - ﬁ’a Service Devel.. [ EntireX %% Debug >
5. Navigator 52 =0 CALCP.NSP &3 =0
dlesladm|| © _ -
£ Moxec-Passwords ‘ ASSToN RPC-CHTE . FUNCTION = +SL+ /o Sen REC a1 prox
12 NatONE-NaturalClient-» <unknown> (2) * AoofEH RELTCEIE.EE - (SR /7 SR REL compext and fogen to brokes
G settings CALLNAT 'REC-CNTX' RPC-CNTX
: ADD 1 TO IDX
I
& Natural-Libraries COMPRESS REC—CNTX.ERR-TEXT INTO PROGRESS-MSG (IDX)
& MVLIE . = IF RPC-CNTX.ERR-CCDE NE 0
& NEWLIE e /* error setting RPC context or logon to broker
8 ERR REINPUT FULL REINPUT-MSG
& RES * END-IF
[ MYLIBdI ALS5IGN LOGGED-ON = TRUE
MYLIB.properties ™ L =
(3 SRC *
CALC.NSMN 3%
BE CALCANSA ~% LC: error cccured.' INTQO PROGRESS-MSG (IDX)
[EE CALCP.INSP »% i :
ELLO.NSN % CPERRTOR [+
2¥ HELLOANSA % OPERENDL |
[EE HELLOP.NSP ~% OPERRND2 i
3¢ NATRPCLNSL *% RESULT
SQUARE.NSMH % CCHPRESS 'Calling C : success.' INTO PROGRESS-MSG (IDX)
(B . % - .
¥ SQUAREANSA ~% 2
=H Matural Server 23 o= ®|2% =08 LS5IGN RPC—-CNTX.FUNCTION = 'LF' /= Logoff from broker
LNAT 'REC-CNTX' REC-CNTX
ADD 1 TO IDX
COMERESS REC—CNTX.ERR-TEXT INTO PROGRESS-MSG (IDX)
= IF RPC-CNTX.ERR-CODE NE 0
/* error logoff from broker S
4 F
nf Writable Smart Insert 17:23
5

Using the Generated Sample Natural Program

Before you use the generated sample Natural program (extension .NSP), make sure the Natural
library SYSEXT is defined as a steplib for the Natural environment. Use one of the following
methods, depending on your environment:

® for NaturalONE, use the context menu of the Natural ONE project and choose Properties >
Natural > Environment, add SYSEXT

® for Natural Security environments, use SYSSEC

® for any other Natural environment, use NATPARM

The generated sample Natural program (extension .NSP) demonstrates standard RPC usage and
cannot be used for reliable RPC. For reliable RPC, see Reliable RPC Client Example - SENDMATL.

See also the readme files of the Client and Server Examples for Natural for more information on
working with Natural RPC clients.
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Using the Natural Wrapper for the Server Side

= Using the Natural Wrapper for the Server Side within NaturalONE
= Using the Natural Wrapper for the Server Side with a Remote RPC Environment
= Sample Generation Result for the Server Side

Using the Natural Wrapper for the Server Side within NaturalONE

= Step 1: Specify the RPC Environment
= Step 2: Customize Natural Server Names

Step 1: Specify the RPC Environment

The first wizard page prompts you to select an existing RPC environment or define a new one.
When running with NaturalONE, a default RPC environment is available. This is typically named
"localhost:1971@N ATSRV2800" and refers to a running EntireX broker and Natural RPC server
on the local machine.
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i ™
= Natural Wrapper |. | [5] éj

Generate Natural Server
The Matural server will be generated from the selected Software AG IDL file. =)

This Wizard will help you to generate MNatural server from a Software AG IDL file. Select or
create a new RPC environment.

(") Create a new RPC environment

@ :Use existing RPC environment: ;

=l localhost:1971 @RPC/MATSRV2800/CALLNAT

[l Madify the selected RPC environment

@:l < Back Mext = | [ Finish ] | Cancel

b

Check Use existing RPC environment, select the default RPC environment for NaturalONE and
press Next. Continue with Step 2: Customize Natural Server Names.

Changing the default RPC environment for NaturalONE is not required and not recommended,
so it is best to uncheck Modify the selected RPC environment. More information on changing an
RPC environment can be found in Step 2: Edit the RPC Environment (Optional) under Using the
Natural Wrapper for the Server Side with a Remote RPC Environment.

To use a different Natural RPC server for generation, create a new RPC environment. See Step 1:

Specify the RPC Environment under Using the Natural Wrapper for the Server Side with a Remote
RPC Environment.

This feature requires support from the Natural RPC server used for generation. See Prerequisites
for Natural Wrapper in the respective section of the Release Notes for version number required.
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Step 2: Customize Natural Server Names

On this page, adapt the names for the Natural RPC server (subprograms (NSNs) with their para-

meter data areas (PDAs)) and specify the location to which all Natural sources are to be written.

= Matural Wrapper l = éj

. . i
Customize Natural Server Names Used for IDL Library EXAMPLE =
On this page you can adapt the names to be used for Matural Server Subprograms and Matural Server PDAs,
Adapt names used for Matural Server:
IDL Program Server Subprogram  Server PDA
P SQUARE SSQUARE] ASQUARE
&Fealc SCALC ACALC
&P HELLD SHELLO AHELLO
Total: 3
Location for the generated MNatural Sources
Container:  NatOME-NaturalServer/Natural-Libraries/NEWLIB/RES
@ Ned> || Finsh ][ Cancel

w

¥

] Note: If your IDL file contains more than one IDL library, the additional column IDL Library

is displayed.

For NaturalONE, the location for the generated Natural sources should be in a Natural project. If
the target container is a source folder of a Natural project, the Natural builder will automatically

compile and build the source.

Press Next to start generation. Continue with Sample Generation Result for the Server Side.
Using the Natural Wrapper for the Server Side with a Remote RPC Environment

= Step 1: Specify the RPC Environment

= Step 2: Edit the RPC Environment (Optional)

= Step 3: Select a Library (Optional)

= Step 4a: Customize Natural Server Names and Save Remotely (Optional)
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= Step 4b: Customize Natural Server Names and Save Locally (Optional)

Step 1: Specify the RPC Environment

The first wizard page prompts you to use an existing RPC environment or create a new one.

.
= Natural Wrapper |. | [5] éj

Generate Natural Server
The Matural server will be generated from the selected Software AG IDL file. =)

-

This Wizard will help you to generate MNatural server from a Software AG IDL file. Select or
create a new RPC environment.

(") Create a new RPC environment

@ :Use existing RPC environment: ;

=l ibmhost2:5403@RPC/NATSRVE2/CALLNAT

[l Madify the selected RPC environment

@:l < Back [ Mext = ] Finish Cancel

» To use an existing RPC environment

1 Check Use existing RPC environment, select the desired RPC environment and press Next.
If your previously defined filter (see Step 2: Edit the RPC Environment (Optional)) matches
more than one Natural library, continue with Step 3: Select a Library (Optional). If the filter
matches exactly one Natural library, continue with Step 4a: Customize Natural Server Names
and Save Remotely (Optional).

2 Check Modify the selected RPC environment if you want to change settings prior to gener-
ation. Press Next and continue with Step 2: Edit the RPC Environment (Optional).

EntireX Natural Wrapper 21



Using the Natural Wrapper

» To create a new RPC environment

m  Check Create a new RPC environment and press Next. Continue with Step 2: Edit the RPC
Environment (Optional).

This feature requires support from the Natural RPC server used for generation. See Prerequisites
for Natural Wrapper in the respective section of the Release Notes for version number required.

Step 2: Edit the RPC Environment (Optional)

On this page, connection and authentication settings for the EntireX Broker and Natural RPC
server are managed, and you define whether the Natural sources are saved remotely on the Nat-
ural RPC Server or locally within Software AG Designer.
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-

= Matural Wrapper

-

||

Edit RPC Environment

Define a new RPC Environment.

Broker Parameters

Broker ID: * ibmhost2:5403
Server Address: RPC/NATSRVBZ/CALLMAT

Timeout (Seconds): 60

EntireX Authentication
User Il

Password:

Extractor Settings

Enter narnes, or use filter for range of values (wildcards * and ? on any position, < and > as final character only).

Library Name:

Program Mame:

Wrapper Settings
() Save locally

(@ Save remotely

Target Library Mame: © NAT*

Environment Name

() Default (ilbmhost2:5403@RPC/NATSRVEZ/CALLMNAT)

@ i0ther::  ibmhost2:5403@RPC/NATSRVEZ/CALLNAT

-

RPC Server Authentication
RPC UserID:

RPC Password:

@ [

<Back | Net> | iivish

Define a new RPC environment or modify an existing one on this page. Required fields are Broker
ID, Server Address and the Environment Name. The timeout value must be in the range 1-9999
seconds (default: 60).

The EntireX Authentication fields apply to the broker.

The RPC Server Authentication fields apply to the RPC server. If the Natural RPC Server is oper-
ating under Natural Security:

EntireX Natural Wrapper
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® Your user ID and password must be defined in Natural Security. If the Natural Security user
ID or password differs from the broker user ID and password, use RPC Server Authentication
- otherwise use EntireX Authentication for both.

" Access to the Natural system library SYSIDL is required.
You can save the generated Natural sources locally or remotely:

* Locally
Sources are saved locally in the Software AG Designer. This setting is preferred if you develop
with NaturalONE. If you select this option, continue with Step 4b: Customize Natural Server
Names and Save Locally (Optional) and save locally.

" Remotely
Sources are saved remotely on the Natural RPC Server. If you save the Natural sources remotely,
you have to specify a target Natural library. Enter either an exact name or use a filter for range
of values. The following wildcards are available:

" asterisk "*" (any position) to list names matching any sequence of characters

" question mark "?" (any position) to list names matching any single character

= greater than ">" (final character only) to list names after

® lower than "<" (final character only) to list names before

Only Natural libraries that reside in the FUSER system file of the Natural RPC server can be

specified. The Natural library specified is not created from the EntireX workbench, it must exist
in the FUSER system file (at least one Natural object stored here).

Press Next. If your filter matches more than one Natural library, continue with Step 3: Select a
Library (Optional). If the filter matches exactly one Natural library, continue with Step 4a:
Customize Natural Server Names and Save Remotely (Optional) and save remotely.

Step 3: Select a Library (Optional)

All Natural libraries that reside in the FUSER system file of the Natural RPC server and that match
the filter defined in Step 2: Edit the RPC Environment (Optional) are listed here. This step is
skipped if exactly one Natural library matches the filter specification defined in Step 2: Edit the
RPC Environment (Optional) In this case, continue with Step 4a: Customize Natural Server Names
and Save Remotely (Optional).
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-

= Matural Wrapper

Select a Library

The Matural objects will be deployed into the selected library,

List of Matural libraries:

Mame

MAT-1929
MNATCLASS
MNATCLIPS
MNATMFLE
MATMFS
MNATQA
MNATZIP
MATIT071
MAT314

Total: 9

[] Qverwrite existing Natural objects

e ¥

Select the Natural library where you want to save the generated Natural sources and press Next.
Continue with Step 4a: Customize Natural Server Names and Save Remotely (Optional).

The Finish is enabled if no related XMM file exists. If you press Finish and the generated Natural
objects already exist from a previous generation, check Overwrite existing Natural objects.

Step 4a: Customize Natural Server Names and Save Remotely (Optional)

On this page, adapt the names for the Natural server (subprograms (NSNs) with their parameter
data areas (PDAs)).
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-

Customize Matural Server Names Used for IDL Library EXAMPLE

= Matural Wrapper I. (=] ﬁ]
i
4=

On this page you can adapt the names to be used for Matural Server Subprograms and Matural Server PDAs,

Adapt names used for Matural Server:

IDL Program Server Subprogram  Server PDA
P SQUARE 5SQUARE] ASQUARE
&Pealc SCALC ACALC
4P HELLO SHELLO AHELLO

Total: 3

[7] Overwrite existing Matural objects

@ Net> | [ Finish | [ cancel |

] Note: If your IDL file contains more than one IDL library, the additional column IDL Library
is displayed.

If the generated Natural objects already exist from a previous generation, check Overwrite existing
Natural objects.

Press Next to start generation.
Step 4b: Customize Natural Server Names and Save Locally (Optional)

On this page, adapt the names for the Natural server (subprograms (NSNs) with their parameter
data areas (PDAs)) and specify the location to which all Natural sources are to be written.
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-

Customize Matural Server Names Used for IDL Library EXAMPLE

= Matural Wrapper I. (=] ﬁ]
i
4=

On this page you can adapt the names to be used for Matural Server Subprograms and Matural Server PDAs,

Adapt names used for Matural Server:

IDL Program Server Subprogram  Server PDA
F SQUARE SSQUARE ASQUARE
&Pealc SCALC ACALC
&P HELLO SHELLO AHELLO

Total: 3

Location for the generated Matural Sources

Container: MaturalWrapper

i @j PMlext » [ Finish l [ Cancel I

d Note: If your IDL file contains more than one IDL library, the additional column IDL Library
is displayed.

Specify the Location for the generated Natural sources. Select a container (folder or project) in
Software AG Designer.

Press Next to start generation. Continue with Sample Generation Result for the Server Side.

Sample Generation Result for the Server Side

The following screen shows the successful generation of .NSN and .NSA objects. The Wrapper
Settings included Save locally in a NaturalONE environment.
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-
2 NaturalONE - NatONE-NaturalServer/Natural-Libraries/NEWLIB/SRC/ACALCNSA - Edipse SDK i i i [E=REER

File Edit Mavigate Search Project Run  Window Help
Ci-EE& a8 @ o4 HER AT IR SRR IS 4 ﬁ Service Devel.. [.| EntireX %% Debug >
U5 Mavigator &3 =0 =0

=R

Q MatOME-MaturalServer-»> cunknown= (1) *
= settings
&= Matural-Libraries *
& NEWLIE *
& ERR
& RES
(S SRC *
B ACALCNSA ~%
B AHELLO.NSA %
Bf ASQUARENSA ~%
SCALC.MSN %
SHELLO.NSMN ~%
SSQUARE.NSM *%

-

SCALC.NSN 1
ZDEFINE DATZ PARAMETER -

® /+ >Natural Source Headsr 000000[]
S R R R R R R R R R R R R R KRR R R R R R R R R R R R R R R R R KRR R R R R R R

=

Pk PDA ACRLC for Interface SCALC.

Sk Path: example.idl

Sk IDL Library: EXAMPLE

/%=  IDL Program: CALC

S

Pk Generated by Software AG,

Joek Watural Wrapper 8.3.0.0

Sk WNatural 08.02.03.0001, SYSIDL &.3.13.0
/%=  on 2012-12-13 13:06:39

S

R R R R R R R R R R R R R R R PR R R R R R R R PR R R R

/* Direction according to IDL

.natural
{2 project 1 OPERATICN (I1) /* inout /%** :inout
=% Natural-Extractor i 1 CPERRND1 (I4) /* inout /** :inout
—u 1 OPERLRNDZ (I4) /* imout /** :inout
=H Natural Server i3 | =H x | =0 1 FUNCTION-RESULT (I4) /% inout /** :inout
END-DEFINE
1 b
o* | Writable | Smart Insert | 1:1
~ _ 4

See also the readme files of the Client and Server Examples for Natural for more information on
working with Natural RPC clients.
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3 RPC Environment Manager

The RPC environment is managed on the RPC environment preference page. The RPC environments
can be created, edited and removed. There are several types of RPC environment: Natural, PL/I
and XML/SOAP. The RPC environment type will be used to prepare the selection lists of the fol-
lowing wizards:

® Natural RPC Server

® IDL Extractor for PL/I

= XML/SOAP RPC Server
Use the RPC Environment Monitor to check the availablity of each RPC environment.

Using these wizards, you can add new RPC environments of the respective type. To manage these
RPC environments, open the Preferences page.
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& Preferences

|type Filker text | RPC Environments Ll v

= Software AG 1| Manage the RPC Environments For XML{SOAP RPC Server, Natural RPC Server and IDL Extractar for PLJL,
Ajax Developer

Application Modeler Table of defined RPC environments:

Business Services Marne Broker ID Server Address [lnsert... ]
Code Generation =N i
Falocalhost, 197 L@RPCMNATSRYZ2B00{CALLNAT localhost, 1971 RPC/MATSRYZE00/CALLNAT ¢

(=) Entires Era :
libroker :197 | @RPC/PLISRYL/CALLMAT libroker: 1571 RPCIPLISRYL/CALLNAT
MET Wirapper T plibroker @RPCS f plibeoker i §

C Wrapper
COBOL Wrapper
Cuskom Wrapper
DCOM Wrapper
Deployment Environments
EJB ‘Wrapper
I0L Extractor For COBOL
10L Extractor for Matural
I0L Extractor for PLIT
0L Extractor for WSDL
Installation
Inkegration Servers
Java \Wrapper
Matural Wrapper
PLJI Wrapper
RPC Environments
Web Service Wrapper
¥ML Mapping Editor
Tatural
UDDI Registries
‘Web Services Stack -

@ Ok ] [ Cancel

To edit an existing RPC environment, select the table row and press Edit.... If multiple entries are
selected, the first entry is used.

To remove an RPC environment, select the table row and press Remove. You can select multiple
environments.

To create a new RPC environment, choose Insert....
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7= RPC Environments |;|®
.

New RPC Environment pu
Define a new RPC Environmeant,
Type: |Matural RPC Server v |

Broker Parameters
Broker ID:

Server Address: ¥ RPC/SRYLICALLNAT | [Edit...

Timeaut (Seconds): | ] |

EntireX Authentication RPC Server Authentication
User ID: | | mPCUsermm: | |
Password: | | RPC Password: | |

Extractor Settings
Enter names, or use filker for range of values (wildcards * and 7 on any position, < and = as final characker only).

Libraty Marne: | |

Program Marme: | |

‘Wrapper Settings
() Save locally
() Save remately

Environment: Mame
() Default

(%) Other: | Matural RPC Server

® [ Finish H Zancel ]

Choose the Type and enter the required fields: Broker ID, Server Address and a unique Environ-
ment Name, which will have the default format brokerID@serverAddress. The given Timeout value
must be in the range from 1 to 9999 seconds (default: 60).

EntireX Authentication describes the settings for the broker, and RPC Server Authentication
describes the settings for the RPC server.

The Extraction Settings are used for the IDL Extractors (Natural and PL/I) only. Use them to
specify the name of the Dataset/Library and the Member/Program name.

The Wrapper Settings are used for Natural Wrapper only, and you can specify the operation type
and target library name (not available for Save locally).
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4 RPC Environment Monitor

The RPC Environment Monitor is part of the EntireX Workbench. It is an Eclipse view that provides
a quick overview of the availability of the defined RPC environments in your workspace.

» To open the RPC Environment Monitor from the EntireX perspective

s Choose Window > Show View > RPC Environment Monitor.

» To open the RPC Environment Monitor from a non-EntireX perspective

= Choose Window > Show View > Other > Software AG > RPC Environment Monitor.
The RPC environments are managed on the Preference page. See RPC Environment Manager.

RPC Environment Monitor 23 2]

Table of defined RPC environments:

Mame EBroker ID Server Address Skatus
:'jp Java RPC Server E localhost:1971 @ RPC/SRYIJCALLNAT Broker Error 0007 0007; RPC/SRYLMCALLMAT not registered
M patural RPC Server @ localhost: 1971 B RPC/MATSRY2800/CALLMAT  Matural RPC Server 6,3,4.4 on WHNT-£86 (NATE311.0)
E‘E ®MLISOAP RPC Server @ localhost: 1971 @ RPC/XMLSERYER/CALLMAT  Entired %ML RPC Server 5.2.2.0.162 Windows =P 5.1 x86,

The status check starts when the view is opened. To force an additional check, choose Refresh
from the Views toolbar. The status check can be cancelled in the dialog that appears or within the
Eclipse progress view. When the check is complete or if it cancelled, the following symbols indicate
the status of the corresponding item. The table will be reloaded every time a status check is started
to make sure all stored RPC environments are available.

33



RPC Environment Monitor

Symbol | Status

| Running.
e Not running.
E4AN

Unknown (at the beginning of the check or if the check was cancelled).

| Note: Additional status information (including error messages) is displayed when refreshing
the view (by a ping command to all specified RPC servers).
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5 Using the Natural Wrapper in Command-line Mode

B ComMMANGA-INE OPLONS ....iiiiiiii ittt e et e e e et e e e e e e e et e e e e e e e n e
= Example: Generating an RPC ClIENt .........oooiiiiiiiiii et
= Example: Generating @n RPC SEIVEE ........oiiiiiiiiie e
I V(Lo g e Ty o)L= PO PPOPPPPPPPPPRS
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Command-line Options

This section provides the command-line options for the following tasks:

= Generating a Natural RPC Client from an IDL File
= Generating a Natural RPC Server from an IDL File

See Using the EntireX Workbench in Command-line Mode for the general command-line syntax.

Generating a Natural RPC Client from an IDL File

To generate a Natural RPC client from the specified IDL file, use the following command with
options in table below:

-natural:client

Option Description
-brokerpassword|Password used for broker authentication.
-brokeruser User used for broker authentication.

-environment

Name of the environment or an RPC server description.

-help

Display this usage message.

-operationtype

The operation type. Valid values are:

SAVE Generate Natural interface objects remotely on the server side

GET Generate Natural interface objects locally using Software AG Designer

-overwrite

Overwrite existing Natural interface objects on the server side (SAVE command only).

-targetlibrary

The target library for the Natural interface objects on the server side (SAVE command
only).

-rpcpassword

Password used for RPC server authentication.

-rpcuser

User used for RPC server authentication.

Generating a Natural RPC Server from an IDL File

To generate a Natural RPC server from the specified IDL file, use the following command with
options in table below:

36
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-natural:server

Option Description

-brokerpassword|Password used for broker authentication.

-brokeruser User used for broker authentication.

-environment Name of the environment or an RPC server description.
-help Display this usage message.

-operationtype |The operation type. Valid values are:

SAVE Generate Natural interface objects remotely on the server side.

GET Generate Natural interface objects locally using Software AG Designer.

-overwrite Overwrite existing Natural interface objects on the server side (SAVE command only).

-targetlibrary |The target library for the Natural interface objects on the server side (SAVE command
only).

-rpcpassword Password used for RPC server authentication.

-rpcuser User used for RPC server authentication.

Example: Generating an RPC Client

<workbench> -natural:client /Demo/Example.idl -environment Tocalhost:1971@SRV1 <
-operationtype SAVE -targetlibrary MYLIB

where <workbench>is a placeholder for the actual Workbench starter as described under Using
the EntireX Workbench in Command-line Mode.

The name of the IDL file includes the project name. In the example, the project Demo is used. If
the IDL file name describes a file inside the Eclipse workspace, the name is case-sensitive.

If the first part of the IDL file name is not a project name in the current workspace, the IDL file
name is used as a relative (based on the IDL file) or absolute file name in the file system. Thus, the
IDL files do not need to be part of an Eclipse project.
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Example: Generating an RPC Server

<workbench> -natural:server /Demo/Example.idl -environment Tocalhost:1971@SRV1 <
-operationtype SAVE -targetlibrary MYLIB

where <workbench> is a placeholder for the actual Workbench starter as described under Using
the EntireX Workbench in Command-line Mode.

(p  Caution: Take care not to overwrite an existing server implementation with a server skeleton.

We recommend you move your server implementation to a different folder.

Further Examples

Example 1

<workbench> -natural:client /Demo/example.idl -environment localhost:1971@SRV1 <
-operationtype GET

Uses the IDL file /Demo/example.idl and generates the Natural source files in parallel to the IDL file
of the project /Demo. Output to standard output:

Using workspace file:/C:/myWorkspace/.

Processing IDL file C:/myWorkspace/Demo/example.idl to get the Natural interface <
objects via RPC environment Tocalhost:1971@SRV1

Store Natural Source file C:\myWorkspace\Demo/CALC.NSN

Exit value: 0O

Example 2

<workbench> -natural:client /Demo/example.idl -environment localhost:1971@SRV1 <
-operationtype SAVE -targetlibrary TEST

Uses the IDL file /Demo/example.idl and generates the Natural source files on the server side into
the library TEST. Output to standard output:
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Using workspace file:/C:/myWorkspace/.

Processing IDL file C:/myWorkspace/Demo/example.idl to stow the Natural interface <
objects via RPC environment localhost:1971@SRV1
Exit value: 0
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6 Software AG IDL to Natural Mapping

Mapping IDL Data Types to Natural Data FOrMats ............coouiviiiiiiiiii e
Mapping Library Name and Alias ..............
Mapping Program Name and Alias ............
Mapping Parameter Names .....................
Mapping Fixed and Unbounded Arrays ......
Mapping Groups and Periodic Groups .......
Mapping Structures ...........cccceevvvvvveeen.n.

= Mapping the Direction Attributes IN, OUT and INOUT ........cvuiiiiiiieiee e

= Mapping the ALIGNED Attribute ...............

= Calling Servers as Procedures or Functions
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This chapter describes the specific mapping of Software AG IDL data types, groups, arrays and
structures to the Natural programming language. Please note also the remarks and hints on the
IDL data types valid for all language bindings found in the IDL file. See Software AG IDL File in
the IDL Editor documentation.

Mapping IDL Data Types to Natural Data Formats

In the table below, the following metasymbols and informal terms are used for the IDL.

® The metasymbols [ and ] surround optional lexical entities.

® The informal term number (or in some cases number.number)is a sequence of numeric characters,
for example 123.

Software AG IDL Description Natural Data Format |Notes
Anumber Alphanumeric Anumber

AV Alphanumeric variable length A DYNAMIC
AVnumber Alphanumeric variable length with maximum length|A DYNAMIC
Bnumber Binary Bnumber

BV Binary variable length B DYNAMIC
BVnumber Binary variable length with maximum length B DYNAMIC

D Date D 3,5
F4 Floating point (small) F4 2
F8 Floating point (large) F8 2
I1 Integer (small) I

12 Integer (medium) 12

14 Integer (large) 14

Knumber Kanji Anumber 1
KV Kanji variable length A DYNAMIC 1
KVnumber Kanji variable length with maximum length A DYNAMIC 1

L Logical L

Nnumber[.number] |Unpacked decimal Nnumber[.number]
NUnumber[.number]|Unpacked decimal unsigned Nnumber[.number]
Pnumber[.number] |Packed decimal Pnumber[.number]
PUnumber[.number] |Packed decimal unsigned Pnumber[.number]

T Time T 4,5
Unumber Unicode Unumber

uv Unicode variable length U DYNAMIC
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Software AG IDL Description Natural Data Format |Notes

UVnumber Unicode variable length with maximum length U DYNAMIC

See also the hints and restrictions valid for all language bindings under IDL Data Types under
Software AG IDL File in the IDL Editor documentation.

Notes

1. Data type K is an RPC-specific data format that is not part of the Natural language.

2. When floating-point data types are used, rounding errors can occur, so that the values of senders and
receivers might differ slightly. This is especially true if client and server use different representations

for floating point data (IEEE, HFP).
3. Count of days AD (anno domini, after the birth of Christ). The valid range is from 1.1.0001 up to

28.11.2737. Mapping of the number to the date in the complete range from 1.1.0001 on, follows the Julian

and Gregorian calendar, taking into consideration the following rules:

1. Years that are evenly divisible by 4 are leap years.
2. Years that are evenly divisible by 100 are not leap years unless rule 3, below, is true.

3. Years that are evenly divisible by 400 are leap years.

4. Before the year 1582 AD, rule 1 from the Julian calendar is used. After the year 1582 AD, rules 1, 2

and 3 of the Gregorian calendar are used.

See the following table for the relation of the packed number to a real date:

Date / Range of Dates Value / Range of Values

1.1.0000 0 (special value - no date)
undefined dates 1 - 364 (do not use)

1.1.0001 365

1.1.1970 719527 (start of C-time functions)
28.11.2737 999999 (maximum date)

4. Count of tenths of seconds AD (anno domini, after the birth of Christ). The valid range is from 1.1.0001
00:00:00.0 up to 16.11.3168 9:46:39 plus 0.9 seconds. See the following table for the relation of the packed

number to a real time:

Time / Range of Times Value / Range of Values

1.1.0000 00:00:00.0 0 (special value - no time)

undefined times 1 - 315359999

1.1.0001 00:00:00.0 315360000

1.1.1970 00:00:00.0 621671328000 (start of C-time functions)

5. The relation between the packed number of a Date and Time data type is as follows:

tenths of a second per day =24*60*60*10 = 864000

EntireX Natural Wrapper
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number of time = number of date * 864000

315360000 =365 * 864000 1.1.0001 00:00:00.0
621671328000 =719527 * 864000 1.1.1970 00:00:00.0
number of date = number of time / 864000

365 = 315360000 / 864000 1.1.0001

719527 = 621671328000 /864000 1.1.1970

Mapping Library Name and Alias

Client Side

If you are using client interface objects (recommended) generated for the client side (see Using the
Natural Wrapper for the Client Side), the IDL library name as specified in the IDL file (there is no
8 character limitation) is sent from a Natural client to the server. Special characters are not replaced.
The IDL library alias is neither sent to the server nor used for other purposes on the Natural client
side.

If you are using instead so-called stubs generated with SYSRPC (not recommended) or stubless
Natural RPC (also not recommended), the IDL library name as specified in the IDL file is not
supported by Natural. By default, a Natural client sends the library name SYSTEM to the server.
To send a library name other than SYSTEM from a Natural client to a server, the following steps
are required for the client:

® Turn on the logon option.

® Call application programming interface USR4008N to specify the name of the library, otherwise
the name of the current library is sent. The length of the library name sent is limited to 8 charac-
ters.

Server Side

A Natural RPC Server considers the library name (up to 8 characters) received from a RPC client
only if the Natural Logon option is set by the sending RPC client.

= If the RPC client does not set its Natural Logon option, the Library name is ignored by the Nat-
ural RPC Server and the target RPC server (Natural subprogram, extension .NSN) is searched
in the startup Natural library and defined steplibs of the Natural RPC server.

= If the RPC client does set its Natural Logon option, the target RPC server (Natural subprogram,
extension .NSN) must reside in the Natural library, specified as IDL library name in the IDL
file.
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EntireX RPC client components provide a possibility to set the Natural Logon option. See Natural
Logon or Changing the Library Name and the documentation of the EntireX RPC client component.

Mapping Program Name and Alias

Client Side

If you are using client interface objects (recommended) generated with the Natural Wrapper for
the client side (see Using the Natural Wrapper for the Client Side), the IDL program name as
specified in the IDL file (there is no 8-character limitation) is sent from a Natural client to the
server. Special characters are not replaced. The IDL program alias is not sent to the server, but it
is used to derive the suggestion for the source file names of the client interface objects (NSN, PDA,
PGM) instead using the IDL program names. See Step 2: Customize Natural Client Names.

If you are using instead so-called stubs generated with SYSRPC (not recommended) or stubless
Natural RPC (also not recommended) the IDL program name as specified in the IDL must match
the name in your CALLNAT statement. In this case the IDL program is limited to 8 characters.
Example:

CALLNAT 'MYSRV' P1 P2 P3
Server Side

If you are using a so-called client-side server mapping file (see CVM File) the target RPC server
(Natural subprogram, extension .NSN) is located with the help of this file. This has the following
advantages:

® IDL program names do not have to match the target RPC server (Natural subprogram, extension
.NSN) names.

® Target RPC server names (Natural subprogram, extension .NSN) can be customized during
wrapping (see Step 2: Customize Natural Server Names) or during extraction (see Step 6: Redesign
the Interface for Natural Subprograms (Optional) under Extracting Software AG IDL File from a New
Natural RPC Environment in the IDL Extractor for Natural documentation).

® IDL program names are not limited to 8 characters.

The CVM file is generated either during wrapping (see Using the Natural Wrapper for the Server
Side) or during extraction (see IDL Extractor for Natural). It is wrapped into the RPC client compon-
ents and the relevant information is sent from a client to the server. Therefore it is important to
generate or extract the target Natural RPC (Natural subprogram, extension .NSN) server first,
before creating any RPC client component.
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If you are not using a CVM file, the target RPC server (Natural subprogram, extension .NSN) must
match the IDL program name. In this case the length of the IDL program name is limited to 8
characters.

Mapping Parameter Names

The parameter names as given in the IDL file are replaced by artificial names in the generated
Natural interface object (stub subprogram). See parameter-data-definition under Software AG
IDL Grammar in the IDL Editor documentation.

Mapping Fixed and Unbounded Arrays

® Fixed arrays within the IDL file are mapped to fixed Natural arrays. The lower bound is set to
1 and the upper bound is set to the upper bound given in the IDL file.

See array-definitionunder Software AG IDL Grammar in the IDL Editor documentation for the
syntax on how to describe fixed arrays within the IDL file and refer to f ixed-bound-array-index.

® Unbounded arrays within the IDL file are mapped to Natural X-arrays. The lower bound is always
fixed and set to 1.

See array-definitionunder Software AG IDL Grammar in the IDL Editor documentation for the
syntax of unbounded arrays within the IDL file and refer to unbounded-array-index.

Mapping Groups and Periodic Groups

Groups within the IDL file are mapped to Natural groups. See the group-parameter-definition
under Software AG IDL Grammar in the IDL Editor documentation for the syntax on how to describe
groups within the IDL file.

Mapping Structures

Structures within the IDL file are mapped to Natural groups. See structure-definition under
Software AG IDL Grammar in the IDL Editor documentation for the syntax on how to describe
structures within the IDL file.
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Mapping the Direction Attributes IN, OUT and INOUT

The IDL syntax allows you to define parameters as IN parameters, OUT parameters, or IN OUT
parameters (which is the default if nothing is specified). This direction specification is reflected
by Natural as follows:

® Parameters with the OUT attribute are sent from the RPC client to the RPC server. They are always
provided with the call by reference method.

® Parameters with the IN attribute are sent from the RPC server to the RPC client. They are always
provided with the call by reference method.

= Parameters with the IN 0UT attribute are sent from the RPC client to the RPC server and then
back to the RPC client.

® Only the direction information of the top-level fields (level 1) is relevant. Group fields always
inherit the specification from their parent. A different specification is ignored.

See the attribute-11st under Software AG IDL Grammar in the IDL Editor documentation for the
syntax on how to describe attributes within the IDL file and refer to direction attribute.

| Note: If you define an interface object layout in the Natural application SYSRPC, the
meaning of the direction attributes IN and OUT are reversed compared to the IDL:

® IN in SYSRPC is OUT in IDL
® OUT in SYSRPC is IN in IDL

Mapping the ALIGNED Attribute

The ALIGNED attribute is not relevant for the programming language Natural. However, a Natural
client can send the ALIGNED attribute to an RPC server where it might be needed. To do this you
need a Natural interface object (stub subprogram) that has been generated from an IDL file.

See the attribute-11ist under Software AG IDL Grammar in the IDL Editor documentation for the
syntax of attributes in the IDL file and refer to the aligned attribute.
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Calling Servers as Procedures or Functions

The IDL syntax allows definitions of procedures only. It does not have the concept of a function.
A function is a procedure which, in addition to the parameters, returns a value. Procedures and

functions are transparent between clients and server. This means a client using a function can call
a server implemented as a procedure, and vice versa.

Client and Server Side

The Natural RPC does not support functions.
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Handling CVM Files

A client-side server mapping file (CVM) enables the RPC server to correctly support special Nat-
ural syntax such as REDEFINE and other special situations. If one of these elements is used, the
EntireX Workbench automatically extracts a CVM file in addition to the IDL (interface definition
language), or a CVM file is generated by the Natural Wrapper for a server skeleton. The CVM file
is used at runtime to marshal and unmarshal the RPC data stream.

CVM Files in the EntireX Workbench

In the EntireX Workbench a CVM file has to relate to an appropriate IDL file; always keep the IDL
file and the CVM file together in the same folder.

= If there is a CVM file and a corresponding IDL file, at least one of the IDL programs in the cor-
responding IDL file requires server-mapping information to correctly call the target server. For
those IDL programs, there is a CVM entry (line) in the Workbench CVM file.

= If there is an IDL file but no corresponding CVM file, there is no IDL program that requires
server mapping information.

Source Control of CVM Files

Because CVM entries within a CVM file contain text data only, a Workbench CVM file is text-based
(although it is not intended for human consumption). Therefore, you can include it in your source
control management together with the IDL file and the Natural source(s) as a triplet that should
always be kept in sync.

Compare CVM Files

For CVM files in the EntireX Workbench format, you can use a third-party file/text compare tool to
check if two files are identical.

The CVM entries (corresponding to lines in a Workbench CVM file) contain a creation timestamp
at offset 276 (decimal) in the format Y VY YMMDDHHIISST. The precision is 1/10 of a second.
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When is a CVM File Required?

For the IDL Extractor for Natural

Natural Syntax |IDL Extractor for Natural|CVM Regired |More Information

For the Natural Wrapper

Natural Wrapper CVM Required | More Information

IDL program name is not a valid Natural name |yes Step 2: Customize Natural Server Names under
and is therefore adapted, or the Natural Using the Natural Wrapper for the Server Side
program name is customized within Natural ONE
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Writing Applications with the Natural Wrapper

Writing RPC Clients for RPC-ACI Bridge in Natural

Prerequisites

The parameters of the IDL program must contain an A field with a length of at least 254 bytes or
of unlimited length. You need to have dynamic data types in your IDL. You must use COMPR=2
(send buffer completion).

Writing a Natural Client

» To write a Natural client

1 Use CALLNAT for the Natural RPC client.

2 Provide a context for EntireX as described under Interface RPC-CNTX for the Natural RPC
Client Programmer below. See the Natural documentation for details.

The RPC-ACI Bridge reports errors on the ACI side or the Broker for ACI with Natural error 998
(Internal error details). The details contain the error number followed by a description. Use Nat-
ural subroutine USR2030N to retrieve error class, error code and description. The error class for the
RPC-ACI Bridge is 1018. See Message Class 1018 - EntireX RPC-ACI Bridge under Error Messages
and Codes.

For error handling, use for example (the declarations of the variables are omitted):

ON ERROR
IF *ERROR-NR = 998 THEN
CALLNAT "USR2030N' ERR-PARM(*) 0CC RESPONSE
IF 0CC > 0 THEN
MOVE SUBSTRING(ERR-PARM(1), 1, 8) to #fERR-CODE
MOVE SUBSTRING(ERR-PARM(1), 10) to #fERR-DETAIL
WRITE #fERR-CODE
WRITE ffERR-DETAIL (AL=79)
ESCAPE ROUTINE
END-IF
END-IF
END-ERROR
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Interface RPC-CNTX for the Natural RPC Client Programmer

API RPC-CNTX s used for providing a context for RPC client applications. RPC-CNTX combines
the functionality of several APIs and is available in library SYSTEM. There is no need for extra
preparations such as setting a STEPLIB or copying APIs from SYSEXT to user libraries.

RPC-CNTX makes the following interfaces from SYSEXT obsolete: USR1071N, (USR4371N),
USR6304N, USR2007N, USR4008, USR4009, USR2071N.

For the usage of RPC-CNTX refer to the test programs generated by the Natural Wrapper, see
Sample Generation Result for the Client Side.

For further information refer to the Natural RPC documentation.

Returning Application Errors from an RPC Server to an RPC Client

Application error codes enable the RPC server to return customer-invented errors back to the RPC
client in a standardized way without defining an error code field in the IDL file.

USR4012N from Natural library SYSEXT may be used to enforce Natural error NAT1999 on the
Natural RPC server and to pass back the provided error text to the RPC client.

Example

/* Application Error

COMPRESS "ERROR: " #fERR-TEXT INTO #LOG-TEXT
/* Send back Application Error to Client
CALLNAT 'USR4012N' USING #fERR-TEXT

For more information:

® Logon to the Natural library SYSEXT within your Natural installation, enter command MENU
and select USR4012N.

" Refer to the Natural product documentation on the on the Software AG Product Documentation
website.

® See the Basic RPC Server Examples - CALC, SQUARE
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Interfaces (APIs) Available in SYSEXT

The Natural library SYSEXT provides APIs for RPC programming. Log on to the library SYSEXT
and enter MENU. To list only RPC-related APIs, enter the keyword RPC. To make these APIs available,
make the necessary STEPLIP settings or copy the APIs from SYSEXT to user libraries. For more
information, refer to the API documentation provided by SYSEXT.

Interface Comment

USR1071N |Set user ID and password for RPC

USR2007N |Set/get RPC default server information.

USR2015N |EBCDIC or ASCII translation table for Natural RPC.
USR2032N |Support of commit for CLOSE CONVERSATION.
USR2035N |Support of SSL.

USR2071N |Support of EntireX Security on client side.

USR2072N |Support of EntireX Security on server side.
USR2073N |Ping or terminate an RPC server.

USR2074N |Set new passsword for NSC user in RPC context.
USR2075N | Terminate EntireX Broker service.

USR4008N |Set library for RPC execution.

USR4009N |Set parameters for EntireX.

USR4010N |Retrieve runtime settings of server.

USR4012N |Support of application error.

USR4371N |Set user ID and ETID for RPC.

USR6304N |Set/get reliable state for RPC execution.
USR6305N |Commit/rollback reliable RPC message(s).
USR6306N |Status of UOWs of current EntireX Broker user.

etc.
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Client and Server Examples for Natural

This chapter describes the examples provided for Natural. All examples here can be found in the
EntireX examples/RPC directory under UNIX and Windows.

Basic RPC Client Examples - CALC, SQUARE

Name Type Description Notes

CALCCLT.NSP |Natural Program |A client application calling the remote procedure (RPC service) |1, 2
CALC, with associated example.idl.

SQRECLT.NSP |Natural Program |A client application calling the remote procedure (RPC service) |1, 2
SQUARE, with associated example.idl.

] Notes:

1. Requires a Natural version supported by Software AG.

2. Application uses a client interface object built with the Natural Wrapper.

For more information see the readme file in EntireX directory examples/RPC/basic/example/Natural-
Client under UNIX or Windows.

Basic RPC Server Examples - CALC, SQUARE

Name Type Description Notes
CALC.NSN  |Natural Subprogram A server application providing the remote procedure|1
(CALLNAT) CALC (RPC service), with associated example.idl.
SQUARE.NSN |Natural Subprogram A server application providing the remote procedure|1
(CALLNAT) SQUARE (RPC service), with associated example.idl.
| Notes:

1. Requires a Natural version supported by Software AG and a Natural RPC Server.

For more information, see the readme file in EntireX directory examples/RPC/basic/example/Natur-
alServer under UNIX or Windows.
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Reliable RPC Client Example - SENDMAIL

Name Type Description Notes

SENDCLT.NSP |Natural Program | A client application calling the reliable remote procedure (RPC |1, 2
service), SENDMAIL, with associated mail.idl.

] Notes:

1. Requires a Natural version supported by Software AG.
2. Application uses a client interface object built with the Natural Wrapper.

For more information see the readme file in EntireX directory examples/RPCl/reliable/NaturalClient
under UNIX or Windows.

Reliable RPC Server Example - SENDMAIL

Name Type Description Notes
SENDMAIL.NSN |Natural Subprogram A server application providing the reliable remote |1
(CALLNAT) procedure (RPC service) SENDMAIL, with
associated mail.idl.

] Notes:

1. Requires a Natural version supported by Software AG and a Natural RPC Server.

For more information see the readme file in EntireX directory examples/RPC/reliable/NaturalServer
under UNIX or Windows.
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